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CHAPTER 12 :  EFLHD STANDARD CADD PROCEDURES 

12.1 – Standard Settings 

12.1.1 – Open a MicroStation File 

ALWAYS check the Project workspace from the “MicroStation Manager” dialog 
box as shown below.   

 

 

Select FLH_X30_English for U.S. Customary (English) projects, and 
FLH_X30_Metric for Metric projects in the Highway Design Section. 

Using the Project Configuration of workspace “FLH_X30_English” will give the 
user access to the X30 Generation of Standard Files (Level library, line styles, cell 
library, color table, text styles, ddb files, etc) and also set the MicroStation in 
Survey Feet Unit environment. 

 

12.1.2- Creating a New CADD File 

 

All design files must be created from a Seed file. A separate two dimensional seed 
file has been developed for English and Metric scale design file. These are 
“Sur_ft2D.dgn”, and “Metric_2D.dgn”.  
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ALWAYS use the seed files from; 
M:\Engineering_Software\Cadd_resource_v8i\X30\Standard\seed\ when 
creating a new file. There is an English one (Sur_ft2D or 3D) and a metric one 
(Metric_2D or 3D). While in the MicroStation Manager Window (the first screen 
that pops up when you open MicroStation), make sure that the workspace is set to 
“FLH_X30_English” under Project.  

Next, rename the file and save it in your project folder. 

 

Note - These seed files have several operating parameters set specific to that 
sheet’s purpose and scale .Some of the parameters are as follows: 

  a. Working Units: Imperial --- Master Unit- Survey Feet (‘)  
                                Sub Unit- Survey Inches (“) 
                              Resolution- 10000 per Survey Foot 
  b. Global origin set to lower left (GO=0,0)     
                                                                                              

See M:\Engineering_Software\Cadd_resource_v8i\X30\Standard\seed\ 

for available standard EFLHD Seed Files. 

 

12.1.3 – Text Styles in use at EFLHD 

See Chapter 4 for Text Styles and how to set Annotation Scale in EFLHD drawings. 

 

12.2 – Border Sheet 

 

 Standard Border Sheets have been developed by the EFLHD Highway Design 
Section and will be used for all EFLHD projects.  

 
 Border design files are accessed through the EFLnet 

http://eflnet.flhd.fhwa.dot.gov/tools/template-drawings.aspx 
 
Originals are kept in the following directory. 

                 “M:\Engineering_Software\Cadd_resource_v8i\Borders\”. 
 

Border template  01-EFLHD_bdr.dgn or 01-EFLHD_bdr-nps.dgn will be used 
for most sheets in the plans. 
(01-EFLHD_bdr-nps.dgn is developed specifically for NPS projects and 
includes the PMIS # and NPS # cells in the upper title block) 
 
Detail border template 01-EFLHD_bdr-nps.dgn will be used for Standards and 
Details on NPS projects. (also includes the PMIS # and NPS # cells) 

 
 English and Metric borders are kept in different models of this border design file.  
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 Designer needs to copy this file into project working directory.  
 

 Rename this file according to the EFLHD’s naming convention [e.g. “01-
lop10(2)_bdr.dgn” for RRP-LOP 10(2) project].  

 
 Edit all project information of the English and Metric border according to the working 

project. 
 

 Attach the edited Border to the Sheet dgn’s as a reference file as required. 
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12.3 – Title Sheet 

The Title Sheet identifies the set of plans, conveys the general type of improvement 
planned, and locates the improvement. The Title Sheet includes, at least the major 
criteria under which the improvement is designed, a sketch showing the location  of 
the proposed project, a State map, a complete index of the sheets in the plan set, and 
the length of project.                                                                    

 Standard Title Sheets for each partner agency have been developed and are 

accessed through EFLnet http://eflnet.flhd.fhwa.dot.gov/tools/template-drawings.aspx 

Originals are kept in the following directory. 

                 “M:\Engineering_Software\Cadd_resource_v8i\Standard_Shts\Titles” 

 Copy these files into your project working directory.  

 Rename the files according to the EFLHD’s naming convention 

 [e.g. “A01-lop10(2)_ttl.dgn” for RRP-LOP 10(2) project].   

 Replace location map and key map for the required State. Edit all required 

information according to the project. 

 

 

Note: Text font, style, and size will not be changed by the users. 
Project border will not be used as reference in the Title design file. 
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12.4 – Symbols and Abbreviations Sheet 

The Symbols & Abbreviations Sheet details all of the standard plan symbols and 
abbreviations currently in use by EFLHD. The symbols and abbreviations should not 
be changed on a project-to-project basis. When a special symbol is required for a 
specific project, show it in the space designated for the Project Specific Symbol. 

 
 

 A standard Symbol and Abbreviation Sheet is developed for EFLHD and will be used 
for all EFLHD projects.  
Access the sheet through EFLnet http://eflnet.flhd.fhwa.dot.gov/tools/template-
drawings.aspx.  See 
M:\Engineering_Software\Cadd_resource_v8i\Standard_Shts\Symbol&Abbre\ 
EFLHD_sym.dgn 

 
 Copy this file into the project working directory.  

 
 Rename the file according to the EFLHD naming convention [e.g. “A02-

lop10(2)_sym.dgn” for RRP-LOP 10(2) project].   
 

 Re-attach the project Border sheet file of your working project directory. 
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12.5 – Location Map Sheet 

The Location Map shows the location and limits of the improvement. The location 
sketch shows physical features that will aid in the identification of the proposed road 
location, including intersecting and adjacent roads, prominent landmarks, towns, 
property lines, and a north arrow. A graphic scale is included for the location sketch so 
the scale will be applicable on reduced size prints. 

 
 Create a new DGN file using “Sur_ft2D.dgn” seed file.  

 
 Name this file according to the EFLHD Naming Convention 

 [e.g. “A03-lop10(2)_loc.dgn” for RRP-LOP 10(2) project].  
 

 Attach your project Border file using reference default model selection (Note the 
Border is drawn for 1”=100’ US Customary).  

 
 Use models in the same Location Map design file, if project has more than one 

Location Map sheet. 
 
12.5.1 – Capture a Google Map image for Location Map 

If you do not have a digitized or CADD drawn location map, you may choose to 
capture an image of the project location/vicinity using other online map sources. 

If using Google Maps, navigate to project location.  Zoom in to provide a scale that 
shows the project limits, major and minor access routes.  Leave enough room to clip 
off the pan/zoom tool in the view. 

 From the Google Maps screen, hit the Print button:
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Choose the Adobe PDF Printer:

  

 

Select the Preferences button: 
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Inside the Printing Preferences dialog box, select the Adobe PDF Settings tab: 

 

 

Hit the Edit button to the right of the Default Settings field. 

 

 

 



 
 

	 Page	12‐10	
 

EFLHD CADD Procedures Guide – MicroStation V8i Edition 
Chapter 12 –                               
EFLHD Standard CADD Procedures 

 

Change the Resolution to the maximum allowed of 4,000 dots per inch. 

 

 

Hit Save As to save this setting for future use. 

 

Give the setting a descriptive name to easily identify the settings file. 

Hit Save. 
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Hit OK on the Printing Preferences dialog: 

 

 

Hit Print.   

 

Print the PDF to the project’s CADD folder or the Plots > Adobe folder. 

Use the Microstation Reference > Attach tool to attach the saved image to the 

Location Map CADD file.  Resizing may be needed.  
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12.6 – Survey Information Sheet 

The Survey Information Sheet shows the horizontal and vertical datum notes (State 
Plane Coordinates; NAD, NAVD, mapping on grid or ground with scale factor; location 
maps showing all primary and secondary control points; sketches of references of 
project control points including staked centerline points (POT, PC, PT, etc.); 
subsurface utilities notes (SUE Level  A, B, C or D); coordinate listing of project control 
points (NEZ plus the type of points); and coordinate listing of proposed alignment or 
staked centerline data. 
 

The EFLHD Survey Office assists Highway Design by providing 
all of the data required for the Survey Info Sheet in the final 
mapping CADD file delivered to Highway Design. 
The Project Manager/Highway Design Manager will notify the 
Lead Designer when the final mapping is available. 

 
 

 You can copy the final mapping CADD file to your project folder OR reference the 
original final mapping file from the Survey > Final Mapping folder. 
 

 Create a new DGN file using “Sur_ft2D.dgn” seed file. 
   

 Name this file according to the EFLHD Naming Convention  
[e.g. “A04-lop10(2)_sur.dgn” for RRP-LOP 10(2) project]. 

 
 Attach your project Border file using Microstation Reference tool. 

Change the scale according to the project requirement. 
 

 Within the Border, include Horizontal Alignments, Existing Features, Datum 
Information, Coordinate Listing, Sketches of References, and other survey 
information from the final mapping CADD file.  

 
 Use Models in the same design file, if project will have more than one Survey Info 

Sheet. 
 
 
 

Some editing of the Sketches of References element symbology 
may be required for printing purposes, to eliminate pen table 
shading of existing features.  
Example; change level name from “E_Utilities” . . .  to AUX_ or 
Default. 
 
EFLHD Survey will notify Highway Design if any updates/ 
revisions are made to the final mapping CADD files. 
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12.7 – Typical Section Sheet 
 

The Typical Section shows the shape of the finished cross-section within the 
construction limits, and represents the appearance of the completed project. It must be 
specific enough to describe the proposed work, its location, and material needed. 

 
 

 Create a new DGN file using “Sur_ft2D.dgn” seed file.  

 Rename this file according to the EFLHD Naming Convention [e.g. For one sheet 
typical sections. The file name will be “B01-lop10(2)_typ.dgn”. Use models if you 
have more than one sheet. The file name will be “B-lop10(2)_typ.dgn”. B1, B2 will 
be the models name for RRP-LOP 10(2) project].  

 
Attach your project Border file . (Attach reference on other models also if you have 
more than one sheet). 
 

 Use models in the same Typical Section sheet design file, if project have more than 
one Typical Section sheet. 

 
 Show sections for Normal Crown and Superelevated areas, as applicable. 
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12.8 – Quantities and Summaries Sheet 

 
The Summary of Quantities tabulation combines and summarizes the contract 
quantities for all pay items. This summary informs prospective bidders where to 
locate work within the plan sheets, the difference between plan quantities and bid 
schedule quantities, if any, and expands on contract bid schedule information. 
 
12.8.1 – EFLHD Quantity Sheet Information 
 
Standard Quantity Design Sheets are developed by EFLHD to improve efficiency and 
consistency in the process of generating quantity summaries and schedules sheets 
for the PS&E Package. 

 
There are two design files and one excel file. 

 
 Border file, 01-EFLHD_bdr.dgn 

(M:\Engineering_Software\Cadd_resource_v8i\Borders\01- EFLHD_bdr.dgn). 
This file is used for borders as referenced to the quantity design sheets in 
each model. 

 
 Quantity Sheet Design File, Quantity.dgn 

(M:\Engineering_Software\Cadd_resource_v8i\Quantity_Shts\Quantity.dgn)  
(This file has different summaries and Schedules on each model) 

 
 Quantity Spread Sheet, Quantity.xls                             

(M:\Engineering_Software\Cadd_resource_v8i\Quantity_Shts\Quantity.xls) 
   (This file has same summaries and Schedules in each of the sheets) 

 
Note: For A/E’s, these files are available through the 
CADD_Resources_V8i.zip download (See Chapter 1.4). 
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12.8.2- Summaries & Schedules Sheets 
 
 
 Step I 
 Copy these files (explained above in Section 12.8.1) into the working directory. 
 Rename these files as per EFLHD Naming Convention (See Section 2 of this 

guide). 
 
 

 Step II 
 Open Quantity Sheet Design file. 
 

Note: This file has the Tabulation of Quantities sheets in the Default Model 
and all  other Summaries and Schedules sheets in different Models of the 
design file. 01-EFLHD_bdr.dgn border file is already referenced to these 
models. You can’t see the border in any of the models as you have changed 
the border file name and directory.  

 
 Reattach all border reference files you need to use with your project border file.  
 
 Click model view at the bottom left and select different Summaries and Schedules 

in your design file.  
 

Some are shown as below:  
 

             
 

Tabulation of Quantity       Clearing And Removals      Construction Signs                  Drainage  
   

 
 The Tabulation of Quantity Sheet is in the Quantity Tabulation Sheet Views  
      model and Summaries and Schedules Sheets are in different models of the  
      design sheet.  

 
 Summaries and Schedules are as follows:  

 i) Clearing and Removals, ii) Construction Signs, iii) Drainage, iv) Earthwork,          
v) Erosion  Control, v) Pavement Striping, and vi) Permanent Sign Sheets. 

 

 



 
 

	 Page	12‐16	
 

EFLHD CADD Procedures Guide – MicroStation V8i Edition 
Chapter 12 –                               
EFLHD Standard CADD Procedures 

 

 The tables of different sheets of each model are linked with Excel worksheets. 
The Excel file has the Summaries and Schedules in different worksheets as 
shown below in red circles:  

 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

The above spreadsheet has seven worksheets and each worksheet has three tables for 
different Summaries and Schedules (sheet1, sheet2 and sheet3). These sheets have a link 
connection with the Quantity Sheet design file. Any changes in the spreadsheet will 
automatically be changed in your Quantity Sheet design file. 

 The link in the Quantity Sheet design file with the Excel file will be lost because of 
a change in directory and files name. To reestablish the link, follow Step III. 
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 Step III 
 
 Open the Quantity Sheet design file. Open Clearing and Removal Models. 

 
 Open Links menu through Edit>Link as shown below: 

 
 

                                  
 
 
 

 The Links Menu for Clearing and Removal Models will appear. 
 

                           
 

 Highlight one line on link menu as shown above and click on Change Source.  
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 Change Source menu will appear. 
 

                           
 

 Select the Quantity excel file from the working directory of the Change Source 
menu. Select all three lines one by one and change the source of the link by 
selecting the same Excel file.  

 
 Change the source of all the links in each Model with the same Excel file. 

 
 Open the Excel file and select the working sheets of Summaries and 

Schedules to use. Edit according to the project information and save the 
Excel spreadsheet file. 

 
 Open the Quantity Sheet design file and select Edit > Update Links as 

shown below. Your design file will be updated according to the Excel 
Spreadsheet. 
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12.8.4 – Engineer’s Estimate – EEBACS and Estimate Spreadsheets 

EEBACS 

EEBACS is LIVE and is the current system in use for generating the engineer’s estimate. 

Refer to the EEBACS site on the FLH webpage > Resources > PS&E Preparation > 
Engineer’s Estimates > EEBACS for general information, system module chapters, users 
guide, user account and new project request forms.  

 
Login with PIV Card  
 
PIV card login for EEBACS is required.  If you don’t have your PIV card, you can request a 
login exemption (this is a separate request from a network login exemption). 

                

Use the “Signature” certificate for login. 

PIV login still requires a system Password (this is a separate password from your network 
login). 

Like your network password, the EEBACS password expires and must be changed every 60 
days. 

If you don’t log in at least once in 60 days, your account will be disabled.  Tip: Set a 
Calendar reminder.  Additional instruction on setting up a Security Question and Answer can 
be found in the Users Guide. 
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Refer to the EEBACS site on the FLH webpage > Resources > PS&E Preparation > 
Engineer’s Estimates > EEBACS for general information, system module chapters, users 
guide, user account and new project request forms.  

https://flh.fhwa.dot.gov/resources/estimate/eebacs.htm 

The primary source for information about EEBACS is the EEBACS User Guide, specifically 
Chapter 2 - Design Module.  

The following provides additional information/tips for creating estimates in EFLHD - 

User Accounts 

• EEBACS-001-AE-Staff-Construction-Contractors-Request-Form. For AE Staff and 
Construction.  

Design A/E’s won’t see any data until they are added to the project team.  

An A/E user with a previous account needs to submit EEBACS-001 with “Restore” 
selected to reactivate their account.  

 

•    EEBACS-002-Government-InHouse-Contractors-Request-Form.  
For Government staff (i.e. users with @dot.gov email addresses); Add New, Modify, 
Disable, Delete or Restore user accounts. 

 
 EEBACS-005-Project Request Form 

Use this form to request a new project, or to modify an existing project. The Project 
Manager is required to sign this form. Submit the PM signed form to the EEBACS 
Design Component Lead.  The project information on the form will be used to create the 
EEBACS Project.  (if the Design Component Lead (Lahoucine) is unavailable, send the 
request to the EFL EEBACS Administrator (Spencer) ) 
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Project Info            

Roles: You will see an alert                                                                                                                    
(yellow triangle) if project roles                                                                                                                                
are missing. On the Team tab,                                                                                                                                
assign a "Highway Design                                                                                                                        
Manager" a "Lead Designer" and.                                                                                                                           
“Project Manager”. 

Most of the other Project                                                                                                                       
Information was filled out when                                                                                                                               
the project was created. Changes                                                                                                                          
to the Project Number, Name,                                                                                                                           
Description, etc. must be done                                                                                                                                
by the Design Component Lead.                                                                                                                             

Press the Edit button to modify                                                                                                                          
the remaining project information.                                                                                                                           
Fill out ALL information                                                                           appropriate for the 
project. 
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Estimate            

Milestone Name: A default/                                                                                                                                    
unnamed estimate will come                                                                                                                                
with the new project.                                                                                                                                                
Edit this estimate according to                                                                                                                   
the current Milestone.                                                                                                                                              

EFL will commonly save 15%,                                                                                                                            
30%, 70%, 95%, 99% and 100%                                                                                                                          
milestone estimates.                                                                                                                                                

DO NOT delete the base                                                                                                                                         
estimate, as the default                                                                                                                                        
settings will be lost. 

Name the last milestone "100%"                                                                                                                             
before promoting the estimate                                                                                                                          
to Acquisitions. 

 

Schedule            

Set up a "Base" schedule. Use “A” for the base schedule letter.  It should be edited to suit 
the needs of the individual project.  If more than one schedule is used for the project, set up 
Schedule A as the "Base" schedule and all others as an "Option" schedules. 

Construction Type: Change this field to the value that most closely matches the project's 
construction type. 

Also, add the Schedule Description and Schedule Termini for the project. 

Line Item Numbers: Line item numbers are very important in EEBACS. Each pay item is 
automatically assigned a line item number. Line item numbers are four digits. Start the first 
line item number with something like 0020 or 0100 or 1000, depending on the amount of pay 
items. 
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Use a value of                                                                                                                                             
20 or 50 for the                                                                                                                                   
Line Item                                                                                                                                   
Increment                                                                                                                                                               
Number. 
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Column Headers           

EFLHD will normally use                                                                                                                              
column headers in the Summary                                                                                                                             
of Quantities plan sheet to separate                                                                                                                   
pay item quantities by alignment or                                                                                                                    
site.                                                                                                                                                                          
Set up column headings based on                                                                                                                          
Name, Route, Area. Etc.                                                                                                                                         

The Page No. field MUST have a                                                                                                           
SPACE inserted if you want the                                                                                                         
field to remain empty on the                                                                                                                                 
Summary Sheet. 

Optionally, create an Allowance                                                                                                                              
column to provide additional                                                                                                                                
quantity used to round the bid                                                                                                                               
quantity to some interval. 

See the Summary of Quantities                                                                                                                           
appendix for more information on                                                                                                                            
creating the output and using the                                                                                                          
spreadsheet. 

 

Adding Quality Incentives         

See the EEBACS User Guide, Chapter 2.5.8 - Adding Incentives, for general guidance. 

EFL Highway Design is responsible for calculating quality incentives for applicable pay 
items.  

It is EFLHD practice to add a Materials Quality Incentive for Section 301, 309, 311, 401, 
402, 405 and 407 pay items.  Follow the guidance notes in the QBS Incentives and 
Adjustments spreadsheet for applying the incentives. 

Do not add quantities of multiple items (in the same Section) together to achieve the 
minimum threshold.  Each pay item should be considered separately.  This includes not 
adding quantities for same items that appear in each Schedule. 
 

It is also EFLHD practice to add a pavement Roughness Quality incentive for 401 and 402 
pay items when there is 0.1 LANE MILES of continuous paving.  Follow the guidance 
notes in the QBS Incentives and Adjustments spreadsheet for applying the incentive. 
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For estimating both incentives, access the Incentives and Adjustments spreadsheet in 
QBS. (https://flh.fhwa.dot.gov/resources/estimate/documents/EFL-TM-ESS-
01_EFL_IncentiveAdjustmentFuel.xlsx) 

Save the worksheet to the project’s Quantity folder. 

 

Material Quality Incentive 

In the worksheet;  Enter the line item #, pay item #, quantity and unit price in the gray fields.  
The incentive price will be calculated for you. 

Multiple tabs are available for additional Schedules if needed. 

 

 

In EEBACS, hit the QUP                                                                                                                            
(Quality Unit Price) button; 
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Fill in the required fields.                                                                                                                                         
It should match what is                                                                                                                                  
shown in the worksheet. 

Toggle the Pay Item Type                                                                                                                                 
to “QM” (Quality Material) 

Save and Close. 

 

 

 

 

 

 

This adds a material quality incentive item to your list of pay items. 

 

 

 

 

 

Pavement Roughness Incentive ___                            

In the worksheet; Enter in the total Lane Miles for the material in the gray area. 

The lump sum incentive price is calculated for you. 
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After the calculation, in EEBACS; 

ADD the incentive pay item to the estimate from the Add Master Pay Item tab.  (keyword 
search “incentive”).  Be sure to select the appropriate item (in this example, it would be the 
40199-0002  Incentive, Roughness). 

 

 

 

 

 

 

 

Go back to the Project Pay Items tab and edit the 40199 incentive item.  Enter the lump 
sum unit price from the worksheet. 

Save and Close. 

This adds a pavement roughness quality incentive item to your list of pay items. 

Update/Create the Construction Estimate and verify that the Incentive items have been 
added correctly. 

 

 

 

 

 

 

 

 

 

      (Currently, the system places the Roughness Incentive under “Other . . . “) 
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Summary of Quantities (Tabulation of Quantities) Sheet     

See the EEBACS User Guide Chapter 2.5.9.1.4 for general guidance. 

Hit the “Generate Sum of Quantities Report” button under the Construction Estimates tab (be 
sure that the estimate and schedules are all up to date). 

 

 

 

 

Three file formats are created (.csv, .xls, .pdf) for the                                                                             
Summary of Quantities Report. 

 

 

The .csv file is used with the prepared summary sheet                                                                                          
(not generally used in EFLHD). 

EFLHD will normally use the Excel .xls spreadsheet to                                                                                    
create the Summary of Quantities plan sheet.  Hide unused columns and resize columns as 
needed.  DO NOT hide the “Line Item No.” column.  It is useful in the Amendment/ 
Contract Modification process. 

Reference or Link the .xls spreadsheet into a Microstation CADD file.  Attach your project 
sheet border to create the Summary of Quantities plan sheet. 

Use the .pdf for a quick review of the summary. 

 

EEBACS Support        

• EFL EEBACS System Admin – Spencer Beale 
• EFL EEBACS Design Component Lead – Lahoucine Ouhssayne 
• EFL EEBACS Acquisitions Component Lead – Janice Martin 
• EFL EEBACS Construction Component Lead – Kim Pellegrini / Rajan Patel  

Submit support requests thru 5-Help, cc. the EFL ServiceDesk and the Component Lead.  
Indicate that it is a “Tier 2” request. 
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Estimate Spreadsheets 

The Engineer Estimating, Bidding, Award and Construction System (EEBACS) was 
temporarily replaced by a series of spreadsheets for use in searching bid history, performing 
unit price analysis, and creating the engineer’s estimate.  
 
The spreadsheets provide the capability to:  
 

• Document project data;  

• Develop a list of the pay items for a project;  

• Record quantities, price pay items, and calculate incentives;  

• Develop Summary of Quantities containing the pay items;  

• Create an independent government estimate for the project (IGE); and  

 

Refer to the Engineer’s Estimate Spreadsheet site on EFLNet > Highway Design tab > 
Estimate Spreadsheets button http://eflnet.flhd.fhwa.dot.gov/tools/ees.aspx for estimating 
resources.  

Additional resources can be found on the FLH Estimates webpage 
https://flh.fhwa.dot.gov/resources/estimate/ 

 

1. The first link takes you to the existing QBS Design Quantity Computation 
spreadsheet.  Designers should be familiar with this spreadsheet already. 
See your HDM for guidance on completing the quantity computation form. 
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2. The next two links take you to the EFLHD FP-03 and FP-14 Bid History. 
Use the appropriate spreadsheet for your project. 

 
Note: The UPA spreadsheet reads from these bid history links.  You can access the 
same data in the UPA spreadsheet. 

 

3. The next two links take you to the Unit Price Analysis spreadsheets for Highway 
Design and Bridge.  Use the spreadsheets to record the results of the bid history unit 
price analysis. 
 
Download the clean version to your project folder and use it to create separate UPA 
sheets for each pay item. 
 
Follow instructions on the INFO tab.  Note that in order to get the latest bid history to 
show up in the UPA spreadsheet, you must  also have the FP14Bid_History.xlsx 
spreadsheet OPEN.  Follow the instructions to “refresh” the bid history. 
- Filter by Date, by Federal Lands Division, by State, etc. 
- Select desired bids.  Use established practices for UPA bid selection.  See your 

HDM for guidance. 
- Hit the “Highlight Prices and Calculate Avg Price” button.   
- PRINT THE SINGLE ITEM UPA TO PDF. 
- Repeat for each pay item.  (IT IS NOT RECOMMENDED TO COPY MULTIPLE 

UPA TABS FOR EACH ITEM IN THE UPA SPREADSHEET). 
- Be sure to PRINT to PDF. 
**Inflation rates are not considered in the bid history spreadsheets.  Note any 
adjustments for inflation in the REMARKS field, if applicable. 

4. The next two links take you to the Engineer’s Estimate spreadsheets. 
The “Information” tab allows you to fill in the project information.   
Follow the instructions as shown.  Yellow fields are for user entry of project info. 
**Note the “Enable Content” prompt at the top.  Click to allow all features to work 
correctly. 
 
- On the “Inputs” tab, fill in the pay item number (yellow fields allow input), 

supplemental description, quantity and unit price used.   
- Edit the Column Headers as needed. 
- AVOID inserting/deleting rows and columns.  It may affect the formulas.  Use the 

HIDE function to eliminate rows and columns.   
- When adding a supplemental description to a pay item, add it under the 

“Additional Description2” column.  Use ALL CAPS in the supplemental description 
to match the pay item format. 

- On the “EE_Summary” tab, fill in the supplemental project information that will 
show up on the estimate summary page.  (yellow fields allow user input) 

- Data on this page should be consistent with other PS&E documents 
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Save ALL files to the M:\Projects folder. 

It is suggested that you create a new “EE” folder under the Distribu > In-House and/or the 
Quantity > In-House folders for these documents at each milestone. 

Always submit the LATEST VERSION of the engineer’s estimate spreadsheet 
to PSERT.  If you need to transfer your EE data to the latest spreadsheet, 
follow these steps; 

 On the Information tab, copy the yellow boxes from the old spreadsheet to the 
new.  This can be done in one step (except for the extra Partner and Funding blocks, 
which would be a second step).  Normally the lighter yellow cells don’t need to be 
copied unless they were changed.  Always use the “special” paste options to copy 
values only (right click -> Paste Options -> Values (V) [Picture of capital A]).   

 Similarly, copy the yellow cell blocks on the Inputs tab, pasting with the “Values” 
option.  Copy the data in four steps: Pay Items (cells E5:E?), Description2 to Col 13 
(cells J5:W?), Account2 to Amend (cells Z5:AF?), and the column headings (cells 
K2:W3).  If you wait until the end there will be no need to copy the Added Pay Item 
cells since these should be all removed before it gets to Acquisition. 

 On the EE_Summary tab, copy only the yellow cells, again using the Paste Values 
option. 

 If data was placed on the GIS tab, then copy cells N2:AA?, then paste using the 
Values option. 

 If the spreadsheet data is transferred during the Acquisition process, then this same 
process should be followed for the Bid Tabs Summary tab. 

There is no need to unprotect the sheets to copy data as long as you only copy the data 
indicated above. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

	 Page	12‐33	
 

EFLHD CADD Procedures Guide – MicroStation V8i Edition 
Chapter 12 –                               
EFLHD Standard CADD Procedures 

 

 

12.9 – Plan and Profile Sheets 

The designer may incorporate plan and profile sheets, plan sheets, line graphs, or 
other descriptive sheets that describe the proposed work. When laying out plan and 
profile sheets, avoid dividing major structures, highway intersections, interchanges, or 
grade separations between sheets.   

 

See GEOPAK V8i Section 2.1 to create Plan & Profile Sheet Clipping using 
Geopak Civil Software. 
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12.10 – Approach Roads and Parking Areas 

Plans, profiles, and details for approach roads, parking areas, turnouts, and other 
associated roadways may be placed in a single section or in multiple sections as 
appropriate. It may be appropriate to include approach road plans with the mainline 
plan and profile sheets. Use unique stationing for designed approach roads and 
secondary roads. 
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12.11 – Erosion and Sediment Control Narrative and Sheets 

 A standard Erosion and Sediment Control Narrative Sheet is developed for EFLHD 
and will be used for all EFLHD projects with Erosion and Sediment Control Plans.  
 
Access the Narrative Sheet through EFLnet 
http://eflnet.flhd.fhwa.dot.gov/tools/template-drawings.aspx 
 
Original is kept at; 
M:\Engineering_Software\Cadd_resource_v8i\Standard_Shts\ESC_Narrative 

 
 Copy this file into the project working directory.  

 
 Rename the file according to the EFLHD naming convention  

[e.g. “M01-lop10(2)_e&s_nar.dgn” for RRP-LOP 10(2) project].   
 

 Re-attach the project Border sheet file from your working project directory. 
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12.12 – Temporary Traffic Control 
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12.13 – Permanent Traffic Control 
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12.14 – Drainage Cross Sections, Pipe Profiles and Details 
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12.15 – FLH Standards and EFLHD Details 

12.15.1- Introduction 

FLH Standard Drawings are intended to cover various design elements and be 
applicable nationwide. They have been posted on the Western Federal Lands 
Highway Division office website for repetitive use in the plans. Each standard 
drawing is available in both Metric and US Customary units and conforms to the 
FP-03. 

EFLHD Detail Drawings are also created within the Division on a continual basis 
by the Highway Design office to clarify the work required in the plans. 

12.15.2 -  EFLHD Policy 

The following are the EFLHD policies regarding Standard Drawings and EFLHD Detail 
Drawings: 

 All three Divisions have one set of Standard Drawings known as the FLH Standard 
Drawings. These Standards Drawings are located on the WFLHD website. 

          https://flh.fhwa.dot.gov/resources/standard/ 

 Each Division also has their own set of Detail Drawings.  
EFLHD Detail Drawings are located on the EFLHD Intranet - Highway Design Tab   
https://flh.fhwa.dot.gov/resources/standard/efl/ 

EFLHD Detail Drawings are also available in the following directory:  - 
M:\Standards_and_Details\EFLHD_Detail-Drawings\FP-14 

 Use EFLHD Detail Drawings when there is no available FLH Standard Drawing 
and/or when the Standard is not appropriate for the project.  
 

 FLH Standard Drawings and Eastern Federal Lands Detail Drawings may be 
modified based on individual project requirements. In addition, project-
specific details may be developed to address situations not covered by any of 
the existing Standards or Details in the library. Include modified FLH 
Standards, EFLHD Details, and completely new project-specific Details in the 
95% PS&E review package. As soon as the 95% PS&E package is submitted 
for review, send an email through the HDM to the EFLHD Design Services 
Team (DST), attn. LOS/Detail Coordinator. Clearly describe all modifications 
made to each FLH Standard or EFLHD Detail, and provide a brief explanation 
of need for the modifications, as well as the need for project-specific Details. 
For any modified FLH Standards, EFL Details, or project-specific Details 
added to the plans after the 95% distribution, submit another email to the DST 
describing any modifications made to those new drawings only. 
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  When FLH Standard Drawings are modified, renumber as follows: 

i) Modified Standard Drawings become Project Specific Detail Drawings. 

ii) Change Drawing Numbers by adding alphabetic characters.                                                         
(e.g. Standard Drawing # 635-01 will be renumbered as Project Specific 
Detail Drawing # 635-01A).   

iii) Replace the word “Standard” with “Detail”. 

iv) Replace “Federal Lands Highway Division” with “Eastern Federal Lands 
Highway Division”. 

v) Remove “Standard Approved For Use” and dates. (your changes will not have 
been approved on the FLH level) 

vi) Change the File Name to match the new Detail number.                                                                
(e.g. A  Standard file name st63501.dgn would change to st63501a.dgn). 

 

 When EFLHD Detail Drawings are modified, renumber as follows: 
 

i) Modified EFLHD Detail Drawings become Project Specific Detail Drawings. 

ii) Remove “Detail Approved For Use” and dates. (your changes will not have 
been approved on the EFL level). 

 
iii) Change Drawing Numbers by adding alphabetic characters. 

(e.g. EFLHD Detail Drawing # E633-02 will be renumbered as Project specific 
Detail Drawing # E633-02A for the English version). 

iv) Change the File Name to match the new Detail number.   
 (e.g. A  EFLHD Detail file name st63302_detail.dgn would change to 
st63302a_detail.dgn). 

  When adopting a detail from a DOT /  another source / or creating a completely 
NEW detail, number as follows; 
 

i) New details are Project Specific Detail Drawings. 
ii) Add an “E” prefix and alphabetic character at the end. (e.g. #E602-A) 
iii) Provide a reference to the source of the adopted detail. 
iv) Provide the original source Detail No. 
v) Review/Revise original source detail’s Notes.   

 

Always use FLH Standard Drawings and EFLHD Detail Drawings 
from the original sources/directory as shown above and NOT 
from old project directories. 
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12.15.3 -  Use FLH Standard Details copied from WFLHD Website 

Step I 

 Copy border file “01-EFLHD_bdr.dgn” or  
“01-EFLHD_det_bdr-nps.dgn” from 
“M:\Engineering_Software\Cadd_resource_v8i\Borders\ 
“directory into your project working directory. Change file 
name as per EFLHD naming Convention (e.g. 01-
lop10(2)_bdr.dgn for LOP 10(2) project). 

 

 Open the border file and choose Metric and US Customary 
views from the “View Groups” dialog (Metric and English 
need both views to use Standard drawings downloaded 
from WFLHD Website). 

 

          

 Edit text for your project information “the top right corner of the border”.                                           
(Edit this for both Metric and US Customary views). 

 

                                            

Note: If you already have the Border for your project then skip Step I.  
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Step II 

 Copy/Download the Standard drawing from WFLHD Website. 
 Choose Metric or US Customary views from the “View Groups” as per your 

project requirement. 
 Turn off the following levels from the active files:  

 
D_WFL_Arch 

D_Trad 

   D_EFL_Handles 
   D_EFL_Border 
   D_EFL_Arch 
   D_CFL_Print 

D_CFL_Iplot 

 

 Attach your project border from your project directory. Attach Metric or US 
Customary view as your requirement of your reference file. (Only metric will 
be used for dual unit) 

 Turn off level default and D_EFL_Handles in the border reference file. 
 

Step III  

 Make sure to “Save Settings” for your permanent display. 
 

12.15.4 -  Use EFLHD Details (V8)  

 

Step I 

 Copy border file “01-EFLHD_bdr.dgn” or  
“01-EFLHD_det_bdr-nps.dgn” from 
“M:\Engineering_Software\Cadd_resource_v8i\Borders\ 
“directory into your project working directory. Change file 
name as per EFLHD naming Convention (e.g. 01-
lop10(2)_bdr.dgn for LOP 10(2) project). 

 

 Open the border file and choose Metric and US Customary 
views from the “View Groups” dialog (Metric and English 
both views need both views to use EFLHD Detail 
drawings). 
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 Edit text for your project information “the top right corner of the border”.                                           
(Edit this for both Metric and US Customary views). 

 

                                            

 

Note: If you already have the Border for your project then skip Step I.  

Step II 

 

Copy/Download EFLHD Detail drawing from EFLHD Website.                                                               
Or copy from M:\Standards\EFLHD_Detail-Drawings\V8\ directory. 

  

 Choose Metric or US Customary views from the “View Groups” 
 Re-attach your project Border from your project directory.  

 

Step III 

 Make sure to “Save Settings” for your permanent display. 
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12.16 – Cross Section Sheet 

See GEOPAK V8i Section 2.2 to create Cross Section Sheets Clipping using GEOPAK 
Civil Software. 

 

 

 
 


